Structure Solution and Refinement with Olex2: A guide for Chem 435 Students

Amy A. Sarjeant, Department of Chemistry
Northwestern University, Evanston IL

Version 1.3
12 January 2015

With thanks to Charlotte Stern and Martin Donakowski for helpful contributions and editing. With thanks also to Carla Slebodnick and Greg Girolami for their guides to Olex2 and Shelx.

Table of Contents
Structure Solution and Refinement with Olex2: ................................................................. 2
  Introduction: ..................................................................................................................... 2
  Assumptions: .................................................................................................................. 2
  Description of the Solution and Refinement Procedure: ........................................... 3
  The Olex2 GUI ............................................................................................................. 5
    Setting Up Files ........................................................................................................ 6
      Launching XPREP .................................................................................................. 6
      XPREP .................................................................................................................... 6
    Getting Started in Olex2 .......................................................................................... 11
    Solving a Structure in Olex2 .................................................................................... 11
    Editing the Model and Refining Your Structure .................................................... 16
    Assessing your refinement: ...................................................................................... 17
    Anisotropic Refinement ......................................................................................... 19
    Numbering Atoms ..................................................................................................... 20
    Adding Hydrogen Atoms ........................................................................................ 22
      Calculating Hydrogen Bonds ............................................................................... 24
    Apply an Absorption Correction ........................................................................... 26
      The Face-Indexed Absorption Correction ............................................................ 26
      The Multi-Scan Absorption Correction (SADABS) .............................................. 28
    Going Back In Time ................................................................................................ 29
    Obtaining Metric Data ............................................................................................ 29
    Finishing Your Refinement ..................................................................................... 30
    Making Pretty Pictures ......................................................................................... 33
      Structure Manipulation ...................................................................................... 33
## Structure Solution and Refinement with Olex2:
### A Guide for Chem435 Students

#### Introduction:
This guide is intended primarily as a companion to the Chem 435 course. Some of the commands and procedures are unique to the computing environment used in this course. Olex2 is a freely distributed and continually evolving program. Some features that are available in the class environment may change appearance or functionality, or become unavailable in later versions. The purpose of this guide is to make you familiar with the Olex2 GUI and give you confidence to use the program on your own and in your own computing environment. As you become comfortable with the GUI and the procedures involved, we encourage you to try different options and experiment with different techniques. However, as a beginner learning the basics of crystal structure solution and refinement we suggest you follow this guide closely.

#### Assumptions:
1. You are working on datasets provided by the Chem435 instructors.
2. You are working on the computers available in the IMSERC computer lab (B190). While you will be able to solve and refine structures with Olex2 on other Windows, Linux, and Mac OSX systems, we cannot guarantee the GUI interface will be identical. Download Olex2 from [www.olex2.org](http://www.olex2.org).

### Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labeling atoms and Saving Images</td>
<td>36</td>
</tr>
<tr>
<td>Saving different file types</td>
<td>38</td>
</tr>
<tr>
<td>Creating a CIF File</td>
<td>38</td>
</tr>
<tr>
<td>Advanced Topics</td>
<td>42</td>
</tr>
<tr>
<td>Noncentrosymmetric or Chiral Structures</td>
<td>42</td>
</tr>
<tr>
<td>Twinning</td>
<td>43</td>
</tr>
<tr>
<td>Modeling disorder</td>
<td>44</td>
</tr>
<tr>
<td>Occupational Disorder</td>
<td>44</td>
</tr>
<tr>
<td>Positional Disorder (GUI method)</td>
<td>46</td>
</tr>
<tr>
<td>Positional Disorder (Text-only version)</td>
<td>48</td>
</tr>
<tr>
<td>Viewing Disordered Structures and Other Tools</td>
<td>50</td>
</tr>
<tr>
<td>External Resources</td>
<td>50</td>
</tr>
</tbody>
</table>
Description of the Solution and Refinement Procedure:

Once data have been collected on the diffractometer and integrated by the data processing software, you will typically end up with most, if not all, of the following files:

1. *Filename*_0m.raw – The raw data file which contains all of the reflection indices, their direction cosines, their intensities and errors on the intensities. Some files will also contain header information.

2. *Filename*_0m.hkl – The data file type used in structure solution and refinement packages. Contains only the Miller indices, intensity and errors on intensities for each reflection. (Can contain direction cosines in some cases). This file is often generated by the data scaling program SADABS.

3. *Filename*_0m.p4p – The file that contains most of the experimental data, including the unit cell, orientation matrix, chemical formula, morphology information and data collection parameters. It is produced in Apex2 during the data integration phase.

4. *Filename*.abs – This is the output file from SADABS and contains information relevant to the scaling and absorption correction applied.

In all cases, the “_0m” suffix indicates the file contains the complete, “merged” data from the diffraction experiment and integration. This is not a complete list of files, but represents the ones you will be using the most to solve and refine your structures.

Initially, the only files you will need are the .raw and .p4p files. These will be read by the program XPREP to produce the .hkl and .ins (instructions) files for structure solution. There are several available programs that can be used to solve a structure. This course will focus on the SHELX suite of programs; the structure solution algorithm is called “XS”. Once you have obtained a solution from “XS” you will have a .res (results) and .lst (listing / output) file. Structure refinement is obtained by making changes to the model obtained in your .res file, saving those changes as a new .ins file and running the refinement algorithm “XL”. This cycle is repeated until any change increases the R-factor of the refinement. This procedure is displayed in Figure 1. The entire process can occur within the Olex2 GUI.

The “XM” and “XT” structure solution packages and the new SHELXL-2013 (ShelXL) refinement package are all available to you within Olex2.
Figure 1. Flowchart describing the structure solution and refinement procedure. This can all occur inside the Olex2 GUI.
The Olex2 GUI

Olex2 is not in itself a structure solution and refinement program. It is a graphical user interface (GUI), which combines the programs mentioned above, with a molecular graphics display and several other tools which facilitate structure reporting and will be discussed as needed. The Olex2 GUI is divided into four main parts:

1. **The Main GUI Panel**: This panel contains controls for most of the program’s features. It is divided into five sub-panels, accessed through the corresponding tabs at the top of the panel.
   a. **Home**: This panel contains general information, settings, tutorials and news.
   b. **Work**: The work panel contains three further sub-panels – Solve, Refine, and Report. Each of these contains the components necessary for their respective tasks. These will be discussed in detail throughout this guide.
   c. **View**: This panel contains commands for structure visualization, symmetry generation, geometry calculations and other graphical tools.
   d. **Tools**: Commands to create images, apply restraints and constraints, display chemical information, generate hydrogen atoms, model disorder, create electron density maps and structure matching overlays are held here. Additionally, commands to change the global Olex2 settings are provided on this panel.
   e. **Info**: Information about the refinement statistics and reflection information are found here.
2. **The Graphics Window**: The bulk of the Olex2 interface is taken up by the graphics display. In this large window, your structure model will appear in the foreground, and refinement
and other information appear as text behind it. You can toggle the structure and the text on and off as you see fit, by pressing Ctrl-T. In this window you can make many changes to your structure by clicking the mouse.

3. **The Command Line:** At the bottom of the graphics window, you will find a “>>” symbol which indicates a command line. While most of the commands you will use in Olex2 can be clicked on from the Main GUI Panel, you might find it more efficient to type those same commands in at the command line. Some commands can only be given at the command line, so it is useful to know how it works.

4. **The File Menu:** Running along the top of the screen is the file menu. As with the Main GUI Panel, most Olex2 commands can be called from the file menu. Aside from loading structure models from the “File” menu, this is the least efficient way to control Olex2.

Many of the commands and features of Olex2 have an icon next to them, which will reveal tool tips and helpful information if you click on it!

The Olex2 GUI is highly color-coded. Parameters that are shown in bright green are typically good, those in dull green or yellow are close to good, and those in red are suspicious and should be investigated.

### Setting Up Files

Before you can start solving and refining your structure, you need to take the data files from the integration step and convert them into files that Olex2/SHELX can use. For this you need to run the program XPREP, which can be launched from the Olex2 GUI or from a command line.

#### Launching XPREP

1. To start XPREP from inside Olex2, double-click the Olex2 icon to launch the program.
2. At the command prompt type “reap” or from the File Menu choose “File” → “Open”.
3. Use Windows Explorer to locate the .p4p file of the structure you are trying to solve.
4. Double-click the .p4p file to load it into Olex2.
5. At the command prompt type “xprep.” This will launch XPREP in another window. Follow the commands below (taken from Girolami) to work your way through XPREP.

#### XPREP

(This section is quoted with minimal changes from Greg Girolami’s guide)

4.2) If XPREP asks you to enter the cell parameters \((a \ b \ c \ \alpha \ \beta \ \gamma)\), simply type the appropriate values for \(a \ b \ c \ \alpha \ \beta \ \gamma\) with spaces in between. Normally, however, XPREP finds these values in the .p4p file and you do not need to type them in. Go to step 4.3.

4.3) XPREP will next read and analyze the diffraction data in the .raw file. The first analysis is a table of **Lattice Exceptions.** The table is headed \(P \ A \ B \ C \ I \ F \ Obv \ Rev \ All\), where \(P = \) primitive cell, \(A \ B \ C\) are side-centered cells, \(I = \) body-centered cell, \(F = \) face-centered cell, and \(Obv \) and \(Rev\) are for trigonal and hexagonal cells.
4.4) Look at the bottom number in each column, which gives the average value of the intensities for that lattice condition divided by the error (mean int/sigma). If, for any column, the value in the bottom row is 3 or less (or significantly smaller than the values in all the other columns), the condition is a likely one for your crystal (the smaller the number, the better).

4.5) Look to see what XPREP has written after the words “Select option.” If one of the letters P, A, B, C, I, or F is enclosed in brackets, write down the lattice condition for future reference. Then press <enter> to accept XPREP’s choice. Skip to step 4.7.

4.6) If a question mark is enclosed in brackets [?], this means that XPREP is having trouble recommending a lattice condition. If this happens, look to see which lattice condition has the smallest number in the last line (smallest value for I/σ). Write down this choice for future reference.

Type the letter (P, A, B, C, etc.) of the column that has the smallest mean int/sigma value, unless you know from an earlier attempt to solve the structure that this choice may not be correct. Then go to step 4.7.

4.7) You should now be back in the XPREP main menu, and the suggested option should be to look for higher symmetry [H]. Press <enter> to accept this option.

4.8) XPREP will first print out some information that you can ignore, and then it will display one or more options for the crystal system; each choice is printed in between ----------- dashed lines. (The seven possible crystal systems are triclinic, monoclinic, orthorhombic, tetragonal, trigonal, hexagonal, and cubic).

4.9) If there is only one option between the dashed lines, write down the crystal system of that option for future reference. Then skip to step 4.11.

4.10) If there is more than one option between the dashed lines, record the two options with the lowest FOM values (FOM = figure of merit; note: triclinic always has FOM = 0). Ignore the comment below the table about the original cell.

4.11) If XPREP makes a recommendation for a crystal system, the recommendation will be enclosed in brackets, e.g. [A], which stands for choice A. Write down the crystal system for that choice for future reference. Press <enter> to accept its choice unless you know it to be wrong, and then skip to step 4.13.

4.12) If XPREP has difficulty choosing a crystal system for the unit cell (it will show [?] instead of a letter), it is best to pick the highest symmetry crystal system listed among the possible options. For example, pick orthorhombic over monoclinic, and monoclinic over triclinic, unless you know that the higher symmetry choice does not lead to a solution of the data.

Write down the crystal system of your choice for future reference. Then type in the appropriate letter of the best option, press <enter>, and go to step 4.13.

4.13) After the search for higher symmetry is done, you will be back in the main menu and the
suggested option will be [S] to enter the space group determination routine. Press <enter>.

4.14) The next suggested option will also be [S] to determine the space group. Press <enter>.

4.15) XPREP will then suggest a crystal system (triclinic, etc.). Choose the same crystal system as you did in step 4.11 or 4.12.

4.16) XPREP will then go through the lattice condition routine and make a suggestion (primitive, etc.). Choose the same option as you did in step 4.5 or 4.6.

4.17) Next, XPREP will give a table of possible space groups. If at least one space group appears in the table, skip to step 4.20. If no space groups appear in the table, go to step 4.18.

4.18) If no space groups appear in the table, this means that XPREP has been unable to find any space group that agrees with the systematic absences it finds. If you have previously changed the tolerances, go to step 4.19. If you have not previously changed the tolerances, do the following:

Return to the XPREP main menu by pressing <enter>. Type T to change the tolerances. Type G and make the minimum I/sigma gap half of its current size. Type A and make the maximum mean I/sigma twice its current size. Type E to exit to the XPREP main menu. Go to step 4.7.

4.19) In some cases, XPREP will refuse to identify a space group even after adjusting the tolerances, and you will have to decide yourself what the systematic absences are.

Look at the bottom two entries in each column of the systematic absence exceptions table. A systematic absence is likely if mean intensity or mean int/sigma is significantly less than the values in the other columns. From the probable systematic absences, you should be able to guess a space group. Consult an expert if in doubt. Enter the space group manually by typing its symbol; use minus signs and parentheses to indicate rotoinversions and screw axes, respectively: thus P-1 or P2(1)/c. Then go to step 4.26.

4.20) In the table of possible space groups, the last number in each row is the CFOM number (which stands for combined figure of merit) for each space group. Usually, the smaller the CFOM, the better.

If CFOM is 2 or less, the space group choice is a good one (although not necessarily the right one!). If it is 12 or greater, you will probably have problems solving the data set in that space group.

4.21) Write down the three or four space groups that have the lowest values of CFOM (if there are that many). Record the CFOM values for each.

4.22) Look at the space group with the lowest value of CFOM. If it is a centrosymmetric space group (i.e., if it is labeled ‘centro’ in the Type column), then skip to step 4.26.

4.23) If the space group with the lowest value of CFOM is chiral or non-centrosymmetric, then
answer the following two questions:

a) Of the choices available in the table on the screen, is there a centrosymmetric space group whose CFOM is within 3 units of the CFOM of the “best” space group?

b) Does your crystal contain heavy scatterers (for Mo radiation, atoms with Z greater than 18)?

4.24) If the answer to either question in step 4.23 is “no”, your space group is probably chiral or non-centrosymmetric. Skip to step 4.26.

4.25) If the answer to both questions in step 4.23 is “yes”, it is likely that the actual space group is not chiral or non-centrosymmetric, but is the centrosymmetric space group with the lowest CFOM.

Skip to step 4.28 and override XPREP’s choice with the centrosymmetric space group. If it proves impossible to find a solution in the centrosymmetric space group, you can always re-run XPREP to choose a different space group.

4.26) Above the table of systematic absence exceptions is a number, labeled Mean $|E^*E - 1|$, which has been calculated from the data in the .raw file. Answer the following question: is the value of Mean $|E^*E - 1|$ closer to the value calculated for centrosymmetric space groups or for non-centrosymmetric space groups?

4.27) If the space group with the lowest CFOM is centrosymmetric, and the Mean $|E^*E - 1|$ value is closer to that expected for a centrosymmetric space group, then your space group is almost certainly centrosymmetric. Skip to step 4.30.

4.28) If the space group with the lowest CFOM is chiral or noncentrosymmetric, and the Mean $|E^*E - 1|$ value is closer to that expected for a noncentrosymmetric space group, then your space group is almost certainly chiral or noncentrosymmetric. Skip to step 4.30.

4.29) If neither situation in steps 4.27 or 4.28 is true, your space group is probably centrosymmetric.

For your information, the Mean $|E^*E - 1|$ value becomes an unreliable indicator of whether the cell is centrosymmetric or not in the following cases: (a) heavy scatterers (atoms with Z > 18) are present, or (b) when your data crystal is twinned.

Be prepared to consult an expert if you have trouble solving the structure. For now, however, go to step 4.30.

4.30) If XPREP shows a question mark in brackets [?] as its Select Option, skip to step 4.32. If it gives a recommended space group in brackets: e.g. [F] for option F, go to step 4.31.

4.31) If you like XPREP’s recommended choice, accept it by pressing <enter> and go to step 4.33.
4.32) If you wish to choose a different space group than the one recommended by XPREP (or if XPREP can’t decide and shows [?] as its choice), type the letter corresponding to the option you think is best, then press <enter>.

4.33) After you have chosen a space group, a screen will come up with a table of information about the current data set.

Write down the space group, and from the line that reads “current cell”, write down the values of a, b, c, α, β, γ, and the volume of the unit cell V, which appear in that order.

4.34) XPREP will next suggest option D to merge data sets. Follow this option and the default choices to view a table of the I/σ of your data versus resolution. This will give you an indication of the quality of your data. If the value of Mean I/σ is below 2.0 these data are considered “unobserved.”

4.35) The program will then display a chemical formula for the compound or ask you to provide one. If the formula is not present, enter it manually (the program understands abbreviations such as Me, Et, Ph, etc.). If the formula is incorrect, type F and enter the correct formula.

4.36) Look at the value that XPREP has calculated for Z (the number of formula units per unit cell). Z is always an integer and very often is a power of 2 (1, 2, 4, 8, or 16), and more rarely other numbers (e.g. a multiple of 3 for trigonal and hexagonal space groups).

4.37) Calculate an approximate value of Z using the following formula (which works for many organic and inorganic compounds):

\[ Z = \frac{\text{(volume of unit cell in Å}^3\text{)}}{10 \times \text{the number of atoms in molecule}} \]

This formula often gives values of Z that are more reliable than those suggested by XPREP. More sophisticated methods for estimating Z have also been discussed (see Girolami, G. S. J. Chem. Educ. 1994, 71, 962-964).

4.38) XPREP sometimes miscalculates Z and gives an unreasonable value such as 5; if this is the case, override it by typing Z and then enter in a new value.

4.39) When you are happy with the value of Z, type E to return to the XPREP main menu.

4.40) If this is your second time through XPREP, return to the Face-indexed Absorption Correction section. If this is your first time through XPREP, continue on with step 4.41 and wait patiently for the time when you return to this step. Think how much smarter you will be!

4.41) In the main menu, press <enter> for option F.

4.42) XPREP will then ask for an output filename. The filename you enter should be different from that of the original input file; you can pick any name you like, but it is best to use a name that has something to do with your structure. Write down the new name you chose for future
reference. Type the new name you choose (without an extension) and press <enter>.

4.43) XPREP then asks which file output you would like. Press <enter> to select S, the default value for XS/SHELXS format.

4.44) **Answer Y (for yes) when it asks whether to (over)write the intensity data file** (default is yes). This causes XPREP to create a file called `filename.hkl`.

**NOTE: XPREP also creates a file called `original.prp`, where `original` is the original name of the .raw and .p4p files you started with. This .prp file contains a summary of all the information calculated and all the decisions made while running XPREP. You will need to submit the .prp file generated during your final exam.**

4.45) Quit the XPREP program (type Q). The XPREP window will close and you will be returned to the command prompt. Leave the DOS prompt window open for now.

Phew! Now you are ready to start Olex2. Continue on to the next section.

**Getting Started in Olex2.**

If you have been following through this guide, Olex2 will already be open while you are running XPREP. Otherwise, to start Olex2, simply double-click the icon on the desktop.

1. **You now need to read in the instructions file (.ins) that you set up in XPREP.** At the Command Prompt, type “reap” or in the File Menu, click “File → Open”. This will pop up an Explorer window. If not already in your working directory browse to your working directory.

2. You should see a list of files, the original “_0m” files and the new ones you just created in XPREP. Double-click the `filename.ins` file you just created to load this into Olex2.

3. The main gui panel should have changed to give you the “work, view, tools, info” tabs. Click the “Work” tab. [If the Work tab does not open click another of the tabs and then click back to Work. This is a small bug in the program.]

4. Alternatively if Olex2 is not open, Right-click on the .ins file in a Windows Explorer window and choose “Open With Olex2”

**Solving a Structure in Olex2**

1. **Now that you have loaded your `filename.ins` file into Olex2 click on the Work tab.**
2. Press the \\ button to the right of the word Solve.

3. This will bring up the Solve GUI as shown in Figure 2. Clicking any of the grey headers (Solution Settings Extra, Toolbox Work, History, etc.) will expand those sections. Click the Solution Settings Extra header now.

4. The top part of the Solve GUI shows you which solution program and method you are using, which Reflection (or data) file you are using, the Chemical Composition, Z, Z’ and your estimated Atomic Volume. Your space group is also shown.
   
   a. Each of these drop-down boxes contains a list of the available solution programs and methods.
   
   b. For instance, using the XS program, you can change “Direct Methods” to “Patterson”. And you can change XS to XM to bring up “Dual Space” methods.
   
   c. For the purposes of this manual, we will focus on using XS with either Direct Methods or Patterson methods. However, you might find that XM/Dual Space method works better for the type of structures you will be solving. After you understand the workings of the GUI, experiment with different solution algorithms.
   
   d. **Note:** Olex2 continually defaults back to the olex2.solve and olex2.refine programs. **ALWAYS** check that you are using the SHELX programs (XS, XM, XL) to do your work.

5. The Solution Settings Extra frame contains method-specific settings that you can change to obtain the correct solution. For XS/Direct Methods, the most important of these values is “tref”. Click the “i” icon next to tref to view information about the command. For now, type “1000” in the box and press <enter>. This will change the number of solution attempts to 1000. If the solution you get with 1000 attempts is unreasonable, try increasing this number to 10,000. Olex2 will automatically insert the proper commands into your filename.ins file.

6. Press Solve at the top of the GUI to start the structure solution program.

7. You will see several lines of text scroll by in the graphics window, and you may see some atoms from your structure solution in the window as well. At the command line, type “lines -1” to display all lines of text. Compress the “Solution Settings” window by clicking the “solution Settings header”. Expand the “Toolbox Work” section by clicking its header.

8. Click the button to bring all the “atoms” into view. If this does not work (a small bug), right-click in the Graphics Window and drag the mouse down to zoom out (drag up to zoom in).

9. In order to determine if you have successfully solved the structure, first examine the output of the solution procedure. If the atoms in the graphics window are obscuring the text, Press “Ctrl-
T” until the atoms are hidden and only the text is there. If you have trouble viewing the text against the background, press “F4” to change to a solid background. See Making Pretty Pictures for information on how to change the display settings.

10. Examine the text output in the graphics window. You should see a table with lines such as this:

<table>
<thead>
<tr>
<th>Try</th>
<th>Ralpha</th>
<th>Nqual</th>
<th>Sigma-1</th>
<th>M(abs)</th>
<th>CFOM</th>
<th>Seminvariants</th>
</tr>
</thead>
<tbody>
<tr>
<td>1635773</td>
<td>0.045</td>
<td>-1.000</td>
<td>0.957</td>
<td>1.256</td>
<td>0.045*</td>
<td>+----- +----- +----- +----- +----- +-----</td>
</tr>
</tbody>
</table>

11. Look for the values under CFOM (combined figure of merit). The lower the value, the better the solution. The lowest CFOM value will be marked with a *. A value less than 0.1 is a good sign that your structure is solved. Though, this is only a rough guideline.

12. At the command prompt type “edit lst” to bring up the listing file output from the solution procedure. This file begins with your instructions and then contains a list of rejected reflections (including systematic absence violations), Inconsistent equivalents, results of the solution calculations, locations of found atoms, a two-dimensional “connect-the-dots” style electron density map, and a table of distances and angles for the found atoms. Scroll through the file to look for these things. Make a note if there are many systematic absence violations as this may indicate problems with your data or your space group choice.

13. Look near the bottom of the file where the CFOM histogram table is (CFOM Range Frequency). This histogram shows you the frequency with which a CFOM was found in a particular range. Ideally you will see a large number of “hits” with low CFOM values. If not, you might not have found the correct solution. It is possible to get a correct solution with a higher CFOM value. If this is the case, you can select that solution by editing your .ins file so the TREF line reads: “TREF -1183165” (where 1183165 is the number code of the solution you want, found in the list directly above the CFOM histogram). This number is randomly generated for each machine and each structure solution run. It will not apply if you run a refinement or another solution attempt.

14. When you are satisfied with the .lst file, close it and return to Olex2. Press “Ctrl-T” again until your model appears. Type “Lines 10” at the command prompt if you wish to limit the amount of text that is displayed. (10 is an arbitrary number which you can set to whatever value you like).

15. Now it is time to inspect your structure. If your Q-peaks are not bonded to anything press Ctrl-Q to toggle bonds to Q-peaks on. Rotate the structure by holding the left-mouse button down as you drag the mouse across the screen. Rotate the structure in the plane of the screen by holding Ctrl + left mouse button and dragging the mouse. Zoom the structure by holding the right-mouse button and dragging the mouse up and down, or left and right.

16. Any atoms found by the solution program will show up as a colored sphere. Residual electron density peaks “Q-peaks” are shown as a gold sphere. Figure 3. Shows the default color conventions for Olex2.
17. Q-peaks are positions of concentrated electron density in the map. The “higher” the Q-peak, the more electron density at that position. The highest Q-peaks will represent atoms in your structure not assigned during the solution phase (with XS/Direct Methods). The lower Q-peaks may be atoms, or may be background noise. This is up to you to determine, based on your knowledge of the chemistry involved. XS numbers Q-peaks so the largest peak is Q1. Press “F3” to toggle labels on and off. The ‘height’ of the peaks is designated by how “opaque” the gold sphere is; Figure X shows a Q peak Q1 (at right) that corresponds to a copper atom (Z = 29) to a Q peak Q17 (at left) that corresponds to noise.

18. To view information about the height of each Q-peak, type “info $q” at the command prompt. Alternatively, simply hover the mouse pointer over a particular Q-peak, and a comment box will appear with the peak number and its height. You can also scroll the mouse wheel up and down, or move the “Electron Density Peaks” slider to hide or display Q-peaks. (See the “i” icon for information on how the slider works).

19. Press “Ctrl-Q” or click the button to toggle between show Q / show Q+bonds / hide Q states. By toggling the bonds on, and/or removing weaker Q-peaks, you should be able to pick
out discernible features of your structure from the residual electron density peaks. With the bonds on, simply hover over a bond between an atom and a Q-peak to see the bond distance. If nothing appears to make sense you can:
   a.  Tweak your solution parameters (or try another method) to get a better solution
   b.  Try to name some of the highest Q peaks (described below), refine the structure once and hope more sensible atoms “fall out.”
   c.  Delete all the Q peaks and refine only the atoms that have been assigned.

20. If it looks as though your structure is only partially displayed, it could be sitting on a symmetry element (for instance a centrosymmetric molecule could lie on an inversion center). At the command prompt type “grow”. This will extend any dangling bonds to atoms that are generated by symmetry operations of your space group. It is important to note that this method only generates atoms that are bound to atoms or Q-peaks in your model. Alternatively, your structure may appear to be fragmented, with part of a ligand displaced from the central metal atom, perhaps. If you think this is the case, type “compaq” at the command prompt to bring all the Q-peaks and atoms as close together as possible by symmetry operations. See Making Pretty Pictures for other ways to display your structure.

21. If the Q-peaks make some chemical sense based on your model structure, you will need to assign them to the appropriate atom types. Before you start making changes to your model Press the / button next to the Solve tab to collapse it, and expand the Refine tab, by pressing the \ button next to Refine.
Editing the Model and Refining Your Structure

1. In the Refine window you will see a similar list of programs and methods as in the Solve window. Additionally, the Toolbox, History, Select, Naming and Sorting menus will all still be present. The Toolbox...Sorting menus have the same functionality in Refine as they do in Solve. The programs listed at the top of the window are different. These are the refinement methods. This course will only focus on using the XL refinement program and the Least Squares refinement method. We do not recommend using the other methods available with Olex2 for the assignments in this class (specifically the final exam)! Take care as the GUI tends to default back to the olex2.refine and olex2.solve programs.

2. The Refine GUI also shows the Reflection file used, the Maximum Refinement Iterations, the Number of Residual Peaks, and solvent masking options.

3. To adjust your model, you will first want to assign any Q-peaks that represent atoms in your structure. There are several ways to do this in Olex2:
   a. Click to select all the Q-peaks you wish to assign to a certain atom type and press the button corresponding to that atom type in the Toolbox window.
   b. Click to select all the Q-peaks you wish to assign to a certain atom type an type “name atomtype” at the command prompt (e.g. “name C” to name them all carbon).
   c. Click the button of the atom type you wish you assign in the Toolbox window, and then click the corresponding Q-peaks in the graphics window. [This method puts you in the Name mode which will be discussed later]. Press “Esc” to exit the Name mode.

4. At this point, it is sufficient to assign all the Q-peaks to their proper atom type. We will worry about numbering atoms later.

5. As you make changes to your model, Olex2 will automatically save your changes. If you make a mistake, try pressing “Ctrl-Z” to go back a step. Otherwise you might have to correct the mistake by hand, or go back to a previous refinement stage.

6. Once you have all of your Q-peaks and atoms properly assigned, you will want to refine your model.
   a. Expand the Refinement Settings Extra tab by clicking it.
   b. Under L.S. be sure the first box (nls – number of least squares) is set to “4”. Under plan make sure the first box (npeaks – number of Q-peaks calculated) is set to 20. (These are standard values which can be changed to suit your needs. It is best to start with the defaults first. These values are repeated in the main Refine panel).
   c. Click the check box next to acta to create a CIF file during your refinement. You can click on the “i” icon to reveal additional information for all these options.
   d. To start the refinement, either click the Refine button at the top of the GUI, type “refine” at the command prompt and press <enter> or press “Ctrl-R” to start the refinement process.
NOTE: Olex2 automatically deletes Q-peaks before you run your refinement

7. As your refinement progresses, you will see output from SHELXL scroll past in the graphics window. Scan this output and look for the following items:
   a. The \textit{wR2} value is the R-factor calculated during the least-squares refinement. It is a measure of the agreement between the calculated structure factors (F_{calc}, from your model) and the observed structure factors (F_{obs}, from your hkl file).
   b. The \textbf{Mean} and the \textit{Maximum shift/esd} are a measure of how much your model is moving during the refinement process. In the initial stages of refinement, these values may be relatively large (± 1-5), but as your refinement comes to convergence, this value should approach zero. Once your \textit{Maximum shift/esd} reaches a value below ±0.01, you know your refinement has converged.
   c. If these two values increase or oscillate during the refinement, chances are you have done something wrong. Check your model for any spurious atoms and/or consult an expert.

8. Olex2 will now load the coordinates contained in your \textit{filename}.res file into the graphics window. If you see no gold “Q” peaks, press “Ctrl-Q” until they appear. If you press “Ctrl-Q” at least three times and still see no Q-peaks, check to see if your “Number of Residual Peaks” in the \textbf{Refine} panel is set to 0. If it is set to zero change it to 20 by typing in the box and refine your structure again (step 6d above).

9. Now you need to inspect your results. This will consist of making adjustments to your model in the graphics window, and inspecting your output files for the information they contain.

\section*{Assessing your refinement:}

You should return to this section several times as you proceed in your refinements. Some topics mentioned here might not apply after the first refinement cycle. However, it is good practice to return to this section once you think you are finished refining the structure to be sure you have not missed anything.

1. At the command prompt type “\texttt{edit lst}” to open the listing output from the refinement you just ran. This file begins with a copy of the instructions you used to run the refinement. As you become familiar with the various commands used in the instructions file, it is a good idea to look at this section to be sure you are employing the correct commands. Continue to scan through the \texttt{lst} file to look for the following:
   a. Note if there are significant systematic absence violations. If your refinement proves problematic this could be an indication of what is wrong.
   b. If you see a line that says “Cell contents from UNIT instruction and atom list do not agree” this means that the formula you entered in XPREP (or from your .p4p) does not match your model. Either you are missing atoms in your model or you have too many and therefore your UNIT command is incorrect. Be sure to inspect the table to see which is the case. Check your model in the graphics window to see which is correct.
   c. Scroll to the list of atoms. This table gives their coordinates (x,y,z) the site occupancy factor (sof) and the displacement parameters (U_{eq} / U_{ij}). Look at the values for U_{eq} / U_{ij}. They should be small (on the order of 0.05) but also they should be consistent.
Make a note of any atoms which have anomalous U values (either too big or too small).

d. The table of Principal mean square atomic displacements will suggest to you any atoms that might be split (disordered) over two positions and will flag any atoms that are non-positive definite. Note any atoms that are flagged in these ways and check them in your model to see if they are assigned correctly.

e. Inspect the Analysis of variance tables for any unusual trends in your data. These may give clues that a refinement that is ill-behaved.

f. The list of Most Disagreeable Reflections will show you any reflections obscured by the beamstop (typically low resolution with Fobs close to 0 and Fcalc very large). These you can OMIT from your refinement by inserting an “OMIT” instruction in your .ins file (consult an expert).

g. Inspect the table of bond distances and angles to see if the values are reasonable for the atoms involved. Check the errors on these values, as well, to get a sense of how precise the measurements are.

h. Finally, check the Q-peaks table. The “Peak” column will give you the height of each Q peak. Peaks that are very large can indicate missed atoms. Look for naturally occurring breaks in the heights to determine which peaks could be real and which are just background noise.

2. Exit from the text editor and return to Olex2.

3. Much of the metric data you read in the lst file can be found in the Olex2 GUI.

4. Hover the pointer over an atom and a comment box will appear with the Atom name, the chemical occupancy (as distinct from the site occupancy due to symmetry constraints), and the Ueq value. If the atom is generated by symmetry, the symmetry operators will also be shown.

5. Hover the pointer over a bond and a comment box will appear with information about the bond. Selecting two atoms (bonded or not) and hovering over one of them will give the distance between them. Selecting three will give the angle and four will give the torsion. Note: Olex2 will not give error information in these boxes. See Obtaining Metric Data for ways to calculate bonds and angles with esd’s.

6. To visually inspect the displacement parameters, right-click in the background of the Graphics Window and select “Draw Style → Ellipses & Sticks” or type “telp” at the command prompt. This will display your atoms as ellipsoids sized according to the length of the Uij vectors (or spheres if you are only refining isotropically). If any of your atoms disproportionately large or small you should investigate if they are assigned to the proper atom type.

   a. To change an atom type, click to select the atom and either click the new element type in the Toolbox window, type “name atomtype” at the command prompt, or right-click on the atom and choose “Type” and then select the appropriate element. In all of these cases you can select more than one atom.

7. At this point, you should continue assigning or deleting atoms until your model makes chemical sense. You may need to run several refinements in order to have all atoms appear in the residual electron density map (as Q-peaks). If you are having trouble finding atoms or your refinement “blows up” (wR2 becomes very large and/or the model ceases to make chemical sense) you may want to go back to an earlier stage in the refinement. (See Going back in time
for details).

8. Before you refine your structure again, complete the following tasks:
   a. Check the box next to the weighting scheme (says “Weight”, with two numbers next to it). This will then automatically update the weighting scheme as your refinement progresses. The numbers will turn bright green when the suggested weighting scheme is no longer different from your actual weighting scheme.
   b. At the command prompt type “edit ins” to bring up your instructions file. Add the following commands to the file above the atom list but below the L.S. 4 line, each on a separate line:
      i. BOND $H (If there is a line that reads “BOND” just add the $H. This will include bonds to hydrogen atoms in your CIF file.)
      ii. CONF (This adds torsion angle information to your lst and CIF files).
      iii. Newer versions of Olex2 have a check-box to add these lines to your .ins file automatically. However, if the BOND line is already included, it will not append a $H. Use this function with care, and double-check your .ins file to be sure you’ve added what you want.
   c. Save your file after adding these lines and then save your file again with another name, to keep as a backup. Olex2 has a good method to recover previous refinements, but catastrophe can strike when you least expect it, so it’s always good to have a backup of a known good refinement. See Going back in time for more information on the Olex2 “History” function.

9. Continue refining your structure and adjusting your model until the following conditions are met:
   a. There are no more high Q peaks left in the map. Be certain to check for solvent or other unexpected features of your model. If the highest Q-peak in your map looks suspiciously like it belongs to your molecule, try refining it. If its displacement parameter stays small, then you have found another atom. If it gets large, then chances are it is just noise.
   b. The wR2/R1 and Weight values stop changing.
   c. The Shift/esd either stops changing or becomes very small.

10. The next steps of the refinement procedure can occur in any order. There is no “best” way to follow every time. Choose the method that works best for you, but realize you might need to go back and try a different order. These steps are:
    a. Refine anisotropically.
    b. Number/label your atoms appropriately.
    c. Add hydrogen atoms.

Anisotropic Refinement

1. Once you have most or all of your atoms located, you will want to refine them anisotropically. If you are working on a structure with all light atoms (Cl or smaller) you can usually refine everything anisotropically at once. If you have one or two heavy atoms, or a very poor quality data set, you might want to try refining only a few atoms anisotropically at first.
   Note: Adding anisotropic refinements increases the number of parameters from 6 per atom
to 9, thus increasing the amount of time it takes to run a cycle of L.S. If you have a large number of atoms, this can significantly increase your refinement times.

2. To refine all atoms anisotropically at once, simply click the ellipse button on the Toolbox Work window. If the box next to “Add H” is checked, a refinement will automatically run. It is best to un-check this box when you are first starting with Olex2.

3. To refine only some atoms anisotropically (for instance, the heavier atoms in an organometallic structure), simply select those atoms by clicking on them in the Graphics Window and then press the ellipse button. Again, if the box is checked, a refinement will run automatically. [Alternatively, select the atoms and then type “anis sel” at the command line. This will not run an automatic refinement.]

4. Right-click in the background and select Draw Style → Ellipses and sticks or type “telp” at the command line, to view this structure as an ellipsoid plot. Inspect the atoms that you refined anisotropically. Make sure that they did not turn “non-positive definite” (n.p.d.). You can see this if the atom sphere/ellipse disappears completely and is replaced by a hazy outline.
   a. You can type “edit lst” at the command prompt and scroll past the atom list to the “mean square displacements” list. This will give you information if atoms might be split due to disorder, or if they are non-positive definite.
   b. Olex2 will output a list of atoms that could be split but it will not tell you if an atom is n.p.d. so it is a good idea to look at the .lst file or the ellipsoid plot to be sure. [SHELXL-2012 will tell you how many atoms may be split and how many are n.p.d. but it won’t tell you which ones.]
   c. If you have large thermal ellipsoids you will need to decide if the atoms are assigned improperly (did you mistake a Cl for a Br?) or if they should be split due to disorder. See “Disorder” for more information on treating disordered atoms in Olex2. If you suspect you have incorrectly assigned a noise peak as an atom, delete it and see if your refinement improves or if the Q-peak re-appears.

5. Ensure that you have no n.p.d. atoms or that you have re-assigned any n.p.d. atoms to the proper element type. If after a few cycles of anisotropic refinements you still have n.p.d. atoms and you believe your model to be correct, consult an expert. You may need to add restraints to your refinement.

6. Once your refinement has stabilized again, you can move on to numbering your atoms properly.

Numbering Atoms

1. It is important that your atoms are numbered in a rational manner. If you are working on a series of similar compounds you should try to number them in the same sequence. If you are working on an organic structure with an established numbering scheme, you might want to number the atoms in your structure according to those rules. In any case, you want to number atoms of a given type in a sequential order so C1 bonds to C2 which bonds to C3, etc. It is difficult to read bond/angle tables if atoms are numbered all out of order.

2. Keep in mind that the SHELX algorithms are limited to a four-character naming scheme, i.e.
C001, N1, Cu2A are good; Te15A, C0059 will cause problems. Also keep in mind that Olex2 will allow you to give two atoms the same label, but will automatically re-label one if conflicts are present before the refinement runs. It is wise to double-check your labels before finishing off a structure.

3. There are several methods for numbering atoms in Olex2. Pick the one you feel most comfortable using. To start, make sure your Q peaks are deleted (type “kill $q” at the command prompt) or hidden (press Ctrl-Q until they disappear) and that only your asymmetric unit is displayed (type “fuse” at the command prompt).

4. **Method 1:**
   a. Expand the “Naming” tab by clicking on it.
   b. In the box labeled “Start” enter the number you would like to give the first atom [this could be 1 if you are starting from the beginning, or another number if you are starting in the middle of a series.]
   c. If you want to give the atom a suffix enter it in the box labeled “Suffix” [for instance “W” to label oxygen atoms of water molecules O1W, O2W, etc.].
   d. In the “Type” box type the element symbol for the atom type you wish to assign (default is C for Carbon).
   e. Click the “Name” button to enter “Naming” mode [an orange message box will appear at the bottom of the Main GUI Panel].
   f. Labels will now appear in the Graphics Window and the cursor will change to show the next label you will apply when you click on an atom. Simply click each atom you would like to label in order. The label will turn to black once you click on an atom.
   g. **Note:** Olex2 does not remember the last atom number you used for a given element. You must keep track of this if you stop labeling and start again.
   h. When you are done labeling one element type, press “ESC” to exit “Naming” mode.
   i. To number the next element type, enter the correct values in “Start”, “Suffix” and “Type” and repeat from step “e” above. Continue this until all atoms are labeled appropriately.

5. **Method 2:**
   a. Select all atoms of a given type you wish to number in the order that you would like them numbered.
   b. At the command prompt type “name #” where the # is the number of the first atom (doesn’t have to be 1). This can be useful if you want to number all atoms sequentially without regard to element type.
   c. Continue selecting atoms in order and typing “name #” until all atoms are properly labeled.
   d. This method will not work with only one atom selected.

6. **Method 3:** To number a single atom, select that atom and type “name atomlabel” where “atomlabel” is the exact label you wish to use for the atom, e.g. C1, N2S, Cu5. If you wish to rename an atom you can type “name current new” where “current” and “new” are the old atom name and the new atom name you wish to use, respectively.

7. Once all your atoms are properly labeled, you should sort them. Typically we sort by atomic mass and label and then by moieties, with the main molecule first, then any counter ions and
solvent molecules. Simply sorting by mass and label is often sufficient.

8. The easiest way to sort atoms is to type “sort +ml moiety +s” at the command prompt. This will sort all atoms first by atomic mass and then by atom number; then it will group atoms into individual moieties.
   a. Occasionally, Olex2 will sort moieties into a different order than you would prefer. If this is the case, you will need to edit the ins file manually.

9. To use the Main GUI Panel, expand the “Sorting” tab by clicking on it. First click the “Mass & Label” button, which will sort the atoms first by atomic mass and then by atom number. Then click the “Moieties” button which will group the atoms into moieties, with the heaviest atom listed first.
   a. In the case where you have a small organic molecule and a heavy counter ion (say PF6), this method will list the PF6 moiety first.
   b. Click the “i” icon in the Sorting tab for details on how to sort in different orders or using different flags.

10. When you are all done, type “edit ins” at the command prompt and inspect your atom list. Rearrange any moieties that did not sort in the order you expected (check to see if there is a reason for this). Save this ins file and run a refinement to have the properly numbered and sorted atom list generated in your output (CIF) files.

Adding Hydrogen Atoms

1. Crystallographers rarely refine hydrogen atoms freely. Instead, they are typically placed in calculated positions that “ride” on their parent atoms. If you are lucky enough to have high quality data in which the hydrogen atoms can be located from the residual electron density map, you can assign the Q-peaks to hydrogen atoms, as you would any other atom and refine them freely (though never anisotropically). More likely you will simply add your hydrogen atoms in calculated positions. To do this, follow the steps below.

2. Expand the “Naming” tab by clicking on it and ensure the box next to “Automatic Hydrogen Naming” is checked. This is the default state for Olex2 and is quite handy for routine hydrogen refinements. This allows you to change your atom numbers and have the riding hydrogen labels change along with them. If you need to number your hydrogen atoms differently from their parent atoms, then un-check this box. Close the “Naming” tab when you are done.

3. To automatically add hydrogen atoms to all possible atoms:
   a. Simply click the “Add H” button on the Toolbox Work tab. If the check-box next to this is checked, a refinement will automatically run.
   b. Alternatively, type “hadd” at the command prompt. This will add hydrogen atoms, but will not run a refinement afterwards.
   c. After automatically adding hydrogen atoms, inspect your model to be sure the appropriate types of hydrogen atoms were applied. Remember to expand (“grow”) your structure if only part of the molecule is represented by the asymmetric unit.
4. **To automatically add hydrogen atoms to selected atoms:**
   a. Select the atoms you wish to add hydrogen atoms to by either clicking to highlight them in the graphics window or typing “sel atomnames” where “atomnames” can be specific atom names or variables such as $C or a combination of both.
   b. Follow from step 3a above.

5. **To add hydrogen atoms manually:**
   a. Click the **Tools** button on the Main GUI Panel and expand the “Hydrogen Atoms” tab, by clicking on it.
   
   ![Hydrogen Atoms](image)

   b. Click on the appropriate hydrogen type for the hydrogen atoms you wish to add. In the GUI they are grouped by parent atom hybridization (sp² vs. sp³) and then designated by the number of hydrogen atoms to be added. Clicking on one button will start “HFIX Mode” and an orange box will pop up at the bottom of the Main GUI Panel.
   c. The cursor will change to show you the AFIX code (used by SHELX) that will be used to spawn the hydrogen atom. It’s a good idea to learn the AFIX codes for each hydrogen atom type.
   d. Click each atom you wish to apply the specific hydrogen type to. Olex2 will display a warning message in the text window if it cannot add the hydrogen you ask it to.
   e. Press “ESC” to get out of HFIX mode.
   f. If you have other types of hydrogen atoms to add, click the button corresponding to the next type you want to add and repeat the process from step d above.

6. If you understand SHELX syntax for AFIX commands, you can select the atoms you wish to add a specific hydrogen type to and type “hadd AFIX mn” at the command prompt (where mn is the proper AFIX code).

7. Once all the hydrogen atoms are added, inspect your model (type ‘grow’ to expand your structure if you need to) to be sure that all hydrogen atoms are assigned properly.

8. If the box on the “Naming” tab for “Automatic Hydrogen Naming” is checked, Olex2 will number your hydrogen atoms according to the number of their parent atom as shown below:
9. Refine your structure as you would normally do. If SHELX encounters a problem with calculating hydrogen atom positions, it will exit abnormally and this may cause problems in Olex2. If you can’t access your History tab, you will need to first edit your ins file outside of Olex2 and then re-open it in Olex2. Look at the refinement text that scrolls by in the Olex2 window and find the problematic hydrogen (SHELX will tell you which atoms are causing the problem). Delete the hydrogen atoms along with their AFIX commands from the ins file, save the file and re-open it in Olex2. Run the refinement again. You may have new errors, so you may have to repeat this process several times. If you get annoyed, delete all the hydrogen atoms, and start again. Or, consult an expert.

Calculating Hydrogen Bonds

If you are interested in hydrogen bonding schemes present in your structure, Olex2 can help you determine what possible interactions are present. To have Olex2 search for hydrogen bonding interactions for you, simply type “htab” at the command prompt. You will see text like this in the Graphics Window:

```
Processing HTAB with max D-A distance 2.9 and minimum angle 120
HTAB  02  04 $1  d=2.863
HTAB  04  09 $2  d=2.874
HTAB  05  07 $3  d=2.859
HTAB  07  01  d=2.862
HTAB  08  09 $4  d=2.894
HTAB  09  08 $5  d=2.894
HTAB  010  05  d=2.798
```
You can change the maximum D-A distance and minimum angle to whatever values you choose. The defaults are standard, but programs like PLATON use slightly longer D-A distances and slightly smaller minimum angles. To change the defaults simply enter them at the command prompt by typing “htab 3.0 100” to change them to 3.0Å and 100°, respectively.

The lines that Olex2 produces are commands for your ins file. They will set up a hydrogen bonding table which will be appended to your CIF file for inclusion in your final report. The syntax gives the HTAB command, followed by the donor atom, then the acceptor atom (with a symmetry variable appended to it if needed, e.g. _$1). The d=xxx is not part of the command in the ins file, but Olex2 is telling you what the D-A distance is.

The HTAB command in Olex2 will also insert the proper commands in your ins file, along with the necessary symmetry operators. The lines added to the ins file after the preceding HTAB command in Olex2 look like this:

    EQIV $1 -X, 0.5+Y, 2-Z
    EQIV $2 -X, -0.5+Y, 1-Z
    EQIV $3 1+X, +Y, +Z
    EQIV $4 -1-X, 0.5+Y, 1-Z
    EQIV $5 -1-X, -0.5+Y, 1-Z
    ...
    HTAB  O2 O4_$1
    HTAB  O4 O9_$2
    HTAB  O5 O7_$3
    HTAB  O7 O1
    HTAB  O8 O9_$4
    HTAB  O9 O8_$5
    HTAB  O10 O5

The “EQIV” commands set up the symmetry operators which need to be applied to generate the various acceptor atoms. For example, the first HTAB command involves O2 as the donor atom and O4 from a molecule whose coordinates have been shifted by the symmetry operation –x, ½ + y, 2-z (the 2₁ screw axis).

After adding the HTAB commands and running a cycle of refinements, your lst file will have the following table near the end of the file:

<table>
<thead>
<tr>
<th>D-H</th>
<th>H...A</th>
<th>D...A</th>
<th>&lt;(DHA)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.82</td>
<td>2.06</td>
<td>2.864(4)</td>
<td>165.0</td>
</tr>
<tr>
<td>0.82</td>
<td>2.06</td>
<td>2.874(3)</td>
<td>174.9</td>
</tr>
<tr>
<td>0.82</td>
<td>2.05</td>
<td>2.859(4)</td>
<td>169.0</td>
</tr>
<tr>
<td>0.82</td>
<td>2.06</td>
<td>2.862(3)</td>
<td>166.8</td>
</tr>
<tr>
<td>0.82</td>
<td>2.14</td>
<td>2.894(4)</td>
<td>152.8</td>
</tr>
<tr>
<td>0.82</td>
<td>2.10</td>
<td>2.894(4)</td>
<td>162.1</td>
</tr>
<tr>
<td>0.82</td>
<td>2.02</td>
<td>2.798(4)</td>
<td>159.1</td>
</tr>
</tbody>
</table>

The corresponding data will also be included in your CIF file.
Apply an Absorption Correction

Once all the atoms in your structure have been assigned and you are confident in the chemical formula, you should apply an absorption correction. There are two main types of absorption corrections that you might encounter in your work: a Face-indexed absorption correction and a multi-scan absorption correction. There are pros and cons to each method and ultimately you will have to decide which is best for each structure you solve. We will discuss how to use both methods in this guide, but for the purposes of Chem435, we will focus on the face-indexed correction.

Before running the absorption correction, ensure your formula is correct. If all of your atoms are assigned properly, simply press the “OK” button in the Toolbox Work panel, which will reset your formula. You will see a line in the Graphics Window that reads something like “New content is: C8 H9 F6 N2 P1.” If you have fractional values, check that Z’ (next to the OK button) is correct. If your formula and atom counts match each element button in the Toolbox Work panel will be green.

Run a L.S. refinement to incorporate the new formula in your ins file. Type “edit lst” at the command prompt to bring up your output file. The correct value of μ should be given near the top of the file:

\[ V = 2191.79 \quad F(000) = 1888.0 \quad \mu = 5.54 \text{mm}^{-1} \quad \text{Cell Wt} = 3793.41 \quad \rho = 2.874 \]

Write down the value of μ to compare with what you get from XPREP below, and close the .lst file. Now you are ready to apply your absorption correction.

The Face-Indexed Absorption Correction

The face-indexed absorption correction is a numerical correction that requires the absorption coefficient μ and the size/position of the crystal. A correction for each diffracted ray is calculated and applied to the corresponding reflection. Therefore, it is imperative that you know the exact formula (which is used to calculate μ, the absorption coefficient) and the exact shape (faces) of the crystal. During the data collection experiment, you will learn how to index the faces of your crystal. This step is critical for applying an accurate face-indexed absorption correction. To apply the correction you will use the program XPREP again.

1. At the command prompt, type “xprep” to launch XPREP again.

2. Follow through XPREP as you did above until you get to step 4.40. Then return here for the rest of the XPREP instructions. (Skip to Step 4 below).
3. In the lower right corner of the table on the XPREP main menu page is listed the value of μ in mm⁻¹. Write this number down.
   a. NOTE: if μ = 0.000, you have done something wrong, likely not entering the formula correctly. Choose option [C] and follow the prompts to enter the correct formula and Z.

4. Select option A to enter the absorption correction routine.

5. Choose F from the menu to start the face-indexed correction.

6. XPREP will ask if the data are indexed on the original cell; press <enter>

7. XPREP will read the .p4p file and display the h k l values for each crystal face, and the distance d between each crystal face and the center of the crystal. If these values are not in the .p4p file, you will have to enter them by hand.

8. Record the h k l and d values for the shortest distance (this information may be useful later), and then press <enter> to continue.

9. The X-ray wavelength will be displayed; press <enter> unless you have reason to do otherwise.

10. The value of μ (in mm⁻¹) will be displayed. Compare μ with the value you wrote down from the .lst file. It should be the same (though perhaps with different significant digits). Press <enter>.

11. Accept the defaults for the next three questions (the last one asking about an input file).

12. XPREP will then begin the correction process, which may take a few seconds to a few minutes depending on the number of measured reflections in the .raw file. When the correction process is finished, XPREP will return you to the absorption correction menu. Choose E to exit to the main XPREP menu.

13. Choose F to write out input files as you did in step 4.41. Choose a different filename such as filenameAbsF so that you know it is the face-index, absorption corrected data. This will write out the appropriate .pcf file which you will need later.

14. Type Q to exit XPREP.

15. Now you are back in Olex2. Type “reap” or Choose File → Open and browse to your structure files. Select the files you had been working on. Your structure should appear in the Graphics Window.

16. Olex2 will allow you to refine against an hkl file with a different name from your ins/res files. This is different from standalone SHELX algorithms and can be quite useful. But you must pay attention to what files you are using.
17. In the Refine panel, use the drop-down box to select the hkl file you just generated with XPREP. The values of R-int and I/sig at the top of the Main GUI Panel should change. You can continue refining against the face-indexed absorption corrected data until the refinement has converged.

The Multi-Scan Absorption Correction (SADABS)

The SADABS program (distributed by Bruker as both a standalone program and as part of the APEX2 software/GUI) leverages the high redundancy of data obtained by modern area detector instruments as a means to apply corrections to the data. These encompass a variety of factors affecting the data, one of which is absorption. For a full description of the SADABS program see http://xray.tamu.edu/pdf/manuals/sadabs.pdf. SADABS is a very powerful program and can do much to improve the quality of your dataset. However, because the program uses symmetry information about the Laue group of the dataset in order to calculate its scale factors, it is possible to "correct" your data into the wrong Laue group! It is also possible to scale your data into a centrosymmetric space group when it should be non-centrosymmetric.

We will not be covering how to use SADABS to scale your data. If you have IMSERC staff collect data for you, we can supply you with a scaled dataset. This will be the filename_0m.hkl file in the "work" directory. You will also need the filename.abs file which is the output from SADABS and contains the minimum and maximum transmission factors. If you wish to learn how to run SADABS to scale your data, please seek training from IMSERC staff. If you started working on this structure with both a .raw and .hkl file in your directory, chances are you are refining against the already scaled hkl file. Make sure you understand which file you used the first time around in XPREP.

In order to refine against scaled data, you must select the appropriate dataset in the Refine panel. If you do not change the orientation of your unit cell axes in XPREP, you can simply use the .hkl file you get from SADABS. If you need to re-orient the unit cell, you will need to run XPREP again, this time using the scaled dataset. To do this, make sure the scaled data file is in your current directory, then proceed as follows:

1. At the Command Prompt type “xprep” to launch XPREP.
2. Follow through XPREP as you did above, as though it were the first time! You do not need to apply any absorption corrections in XPREP. You are merely using it to re-orient your .hkl file.
3. Return to Olex2. At the Command Prompt type “reap” or Choose File ➔ Open and browse to your structure files. Select the structure you had been working on. Your structure should appear in the Graphics Window.
4. Olex2 will allow you to refine against an hkl file with a different name from your ins/res files. This is different from standalone SHELX algorithms and can be quite useful. But you must pay attention to what files you are using.
5. In the Refine panel, use the drop-down box to select the hkl file you just generated with XPREP. The values of R-int and I/sig at the top of the Main GUI Panel should change. You can continue refining against the absorption corrected data until the refinement has converged.
   a. If you did not need to re-orient your .hkl file in XPREP, simply use the drop-down box to
select the SADABS corrected file.

**Going Back In Time**

If you run into trouble with your refinement and things start to spiral out of control, or if you accidentally lose your work, you can often go back to an earlier refinement. These files are not saved discretely as you create them. However, Olex2 maintains its own history of your work. If you need to return to a previous refinement, simply open the History tab in the Main GUI Panel, which will show you a set of bars corresponding to each of your previous refinement cycles. The purple bar represents your initial solution, and the color of each of the other bars represents it’s R-factor (the brighter green, the lower the R value). To get back to an earlier refinement, click the bar that represents that particular refinement stage. You can click through several bars to see the model to decide which one you want to choose. The corresponding R-factor from that stage will be shown at the lower right of the plot. However, once you run a refinement all “future” refinement models will be lost. Use the >> to scroll through the refinement list.

![History tab](image)

*Figure 7. The History tab will allow you to revisit an earlier refinement if you find your model has "blown up".*

Clicking on the History Tree tab will show you a tree view of your refinements, including its R-factor and which algorithm (XL, Olex2.refine, etc) was used to generate it.

You can always back-up your files, by editing them (type “edit ins” for instance) and saving them to a different file name. This is a wise practice no matter which GUI you are using to refine your data.

See steps 18 and 19 in **Saving different file types** below for other ways to save your work.

**Obtaining Metric Data**

1. To obtain errors on metric data (bonded or not) click the View button and expand the Geometry tab by clicking on it. Click the link for “Refine and save esd info.” A refinement will run. Then select any two, three, or four atoms and click the link for “Distance and Angles with esd (of selection) the corresponding metric data will appear in the text part of the Graphics Window.

2. **Note:** This method inserts the “MORE -3” command in your ins file, which is incompatible with “WPDB”. Make sure you remove the “WPDB” command before clicking the “Refine and save esd info” link.

3. Click the notepad icon at the top of the Main GUI Panel to bring up the Olex2 log. This will
containing all of the text output from the current Olex2 session. You can cut and paste the metric data you wish to keep and save it to a new text document for later use.

Finishing Your Refinement

How can you tell when your structure refinement is finished? What markers should you look for in order to call your structure “complete”? Every crystallographer runs the risk of missing some aspect of the refinement procedure and submitting an incomplete or incorrect structure for publication. Following the checklist below before “finishing off” your refinement will help guard against these unfortunate errors. Of course, this list is not foolproof, so until you have your crystallographic feet firmly planted under you (and even then it is still a good idea) show your work to an expert for some feedback on things you might have missed.

Ask yourself these questions:

1. **Is my model complete?**
   a. Are there any large Q-peaks still left in the residual electron density map? If so, could they be missed solvent atoms or features of your molecule? Ideally your “highest peak” and “deepest hole” should be small and of similar magnitude. Remember, these peaks are relative. A peak of 1.0e that is ~1.4Å away from an atom might indicate a missed light atom, whereas a peak of 4.0e close to a heavy metal could indicate a poor absorption correction or other spurious diffraction effects. You can try refining these Q-peaks as atoms to see if they improve your model (and make chemical sense!).
   b. Do you have large/elongated displacement parameters? These might indicate disorder that is possible to model. See Modeling disorder for information on how to do this.
   c. Are any of your atoms non-positive definite (n.p.d.)? You must look in the lst file for this information. Olex2 does not supply it in the text output. If you have n.p.d. atoms, be sure you have assigned them correctly. If you are certain they are properly assigned, it is best to consult an expert as there are many causes for this problem.

2. **Have I applied an absorption correction?**
   a. Make sure that you have applied an absorption correction and that your refinement improved after doing so. If you applied a face-indexed correction and the R-factor got worse, check to be sure your faces were indexed correctly and that you have the right formula. If you are having difficulty, consult an expert.

3. **Has my refinement converged?**
   a. Way back in the beginning of this document, we mentioned the Shift/error as something to watch for during the cycles of refinement. When this parameter reaches 0.000 (or close to it – 0.001 is acceptable) your refinement has converged and your atoms have stopped moving positions. *This does not mean your model is complete!*
   b. If the Shift/error does not decrease to zero, look for it during the refinement and note which atom(s) are responsible for the shift. A common cause of a high shift/error is hydrogen atoms with AFIX 137. If this is the case, try changing the offending AFIX 137 to AFIX 33 (fixed positions) to see if this helps. If you cannot isolate the cause of a high shift/error, consult an expert.
4. **Do I have the proper weighting scheme?**
   a. Make sure that you have checked the box to update the WGHT function in the Refine panel of the Main GUI Panel. Make sure that the WGHT function is no longer shifting by large amounts (ideally, not at all).
   b. If you have a very large second term for your WGHT function, this could indicate a poor absorption correction or twinning. If you cannot explain this feature by one of those two reasons, consult an expert.

5. **Do I have any Disagreeable Reflections?**
   a. Click the Info tab in the Main GUI Panel to bring up the information options. Click the Bad Reflections tab to expand it. This will give you a list of your Disagreeable Reflections. Olex2 will flag any in red that it feels should be omitted. In the figure below, note the 2 0 0 reflection has a large Error/esd value (18.45). The Error is calculated based on Fc^2-Fo^2. Therefore, this is indicating that the observed intensity is much lower than it should be (Fcalc is much greater than Fobs). The low miller indices of this reflection suggest it is obscured by the beamstop and should be omitted from the refinement. Simply click the ‘omit’ link to insert an “OMIT” command in your ins file [OMIT 2 0 0] which will exclude this reflection from the refinement.

   ![Bad Reflections Table](image)

   **Figure 8. The Bad Reflections Table from Olex2. Note the large discrepancy between Fobs and Fcalc for the 0 0 2 reflection.**

   b. Alternatively, look at the bottom of your lst file for the List of Disagreeable Reflections. It should look like this:

   **Most Disagreeable Reflections (* if suppressed or used for Rfree)**

<table>
<thead>
<tr>
<th>h</th>
<th>k</th>
<th>l</th>
<th>Fo^2</th>
<th>Fc^2</th>
<th>Error/esd</th>
<th>Fc/Fc(max)</th>
<th>Resolution(A)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>0</td>
<td>0</td>
<td>4.82</td>
<td>962.30</td>
<td>18.45</td>
<td>0.258</td>
<td>3.55</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
<td>41.00</td>
<td>11.26</td>
<td>4.52</td>
<td>0.028</td>
<td>5.00</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>2</td>
<td>1338.12</td>
<td>1020.10</td>
<td>3.62</td>
<td>0.265</td>
<td>4.61</td>
</tr>
<tr>
<td>-2</td>
<td>0</td>
<td>4</td>
<td>1160.16</td>
<td>901.96</td>
<td>3.30</td>
<td>0.250</td>
<td>2.33</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>0</td>
<td>160.28</td>
<td>105.99</td>
<td>3.25</td>
<td>0.086</td>
<td>1.69</td>
</tr>
<tr>
<td>-1</td>
<td>2</td>
<td>4</td>
<td>98.52</td>
<td>44.62</td>
<td>2.79</td>
<td>0.100</td>
<td>1.97</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>1</td>
<td>33.56</td>
<td>57.62</td>
<td>2.68</td>
<td>0.063</td>
<td>2.50</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>4</td>
<td>123.45</td>
<td>77.39</td>
<td>2.54</td>
<td>0.073</td>
<td>1.54</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>2</td>
<td>1384.39</td>
<td>1154.90</td>
<td>2.42</td>
<td>0.282</td>
<td>6.13</td>
</tr>
</tbody>
</table>

   Note the first reflection given (2 0 0) has a very small Fo^2 (4.82) and should have a large Fc^2 (962.30). The resolution is quite low (3.55Å). From this you can tell the reflection is likely obscured by the beamstop and should be excluded from the refinement. Edit your ins file to include the line “OMIT 2 0 0” anywhere before the list
of atoms to exclude this from the refinement.

c. Either method will give you the same list of reflections. It is up to you which you find easier to read (sometimes, it’s best to look at both, since the lst file gives more specific information about each reflection).

d. One thing to note when looking at the Disagreeable Reflections is a trend for all Fobs to be larger than Fcalc. (In the case of the Olex2 table, this will appear as a negative value for \( Fc^2 - Fo^2 / \text{esd} \)). This is often an indication of twinning and should be investigated. See the Twinning section for more information.

e. Alternatively, if all Fobs are smaller than Fcalc, this is a sign that you may have extinction issues. Add an EXTI command to your ins file and complete a refinement cycle. Check the value of EXTI in the lst file. There it will show the value of EXTI and its esd. If the value is significantly greater than its esd, continue to include this command in your ins file. Otherwise, delete it.

6. **If I have a non-centrosymmetric or chiral structure, is my Flack Parameter reasonable?**
   a. See the section on [Noncentrosymmetric or Chiral Structures](#) to learn what additional steps you may need to take when refining such a structure.
   b. If your Flack Parameter or Hooft parameter is somewhere between 0 and 1, you may have missed an inversion center in your refinement or have racemic twinning, or you may have collected with a radiation wavelength insufficient to determine chirality (e.g. using MoKα with only light-atom elements). Run through the Twinning and/or Missed Symmetry sections of this guide for help. If you still cannot solve your problem, consult an expert.

7. **Have I included all metric data?**
   a. Did you include the BOND $H, CONF, HTAB, and WPDB -2 commands in your .ins file?
   b. In older versions of SHELXL “MORE” and “WPDB” commands are incompatible, so remove the MORE command before adding in WPDB and completing another refinement cycle if you are using SHELXL-97 or older.

8. **What are my final R-factors?**
   a. There is no “magic R-factor” below which all structures are “good” or “publishable”. If your model is reasonable and you can explain the problems with it, a high R-factor may indeed be OK to publish. Completely incorrect structures have been published with R-factors as low as 3%! Use your intuition when judging R-factors. If your data look great (high I/sig, low R-int) and your R-factor is high (>10%) something is probably wrong. If your model makes no sense but your R-factor is low, chances are something is wrong as well.
   b. When calling a structure “done” do not focus on getting the lowest R-factor. Make sure your model makes chemical sense; make sure there are no unexplained artifacts in the refinement or data; make sure you did not miss symmetry or twinning.
   c. Most researchers focus only on the final R-value of the refinement to judge its quality and completeness. You should now have a better appreciation for at least a few of the reasons why the R-factor alone is a poor way to judge the quality of a structure.
Making Pretty Pictures

Structure Manipulation

At some point you will want to manipulate your structure model to display a packing diagram, a fully-grown structure, or perhaps a few nearby molecules to show close contacts. To do this, you will be working mostly with the Symmetry Generation tab under the View menu. To follow along with the commands below, start by clicking on the View button and then expand the “Symmetry Generation” tab by clicking on it. You will see three sub-menus

- Symmetry Tools
- Growing
- Packing

![Symmetry Generation Tab](image.png)

**Figure 9.** The three sub-menus under the Symmetry Generation tab.

1. In order to join parts of a structure that may have been disconnected and moved to separate parts of the unit cell, click the “Assemble” button. This can also help situate molecules which may be catenated or otherwise interpenetrated. The “Assemble” button acts the same way as typing “Compaq” at the command line. “Compaq” is somewhat more powerful as it has different options. Type “help Compaq” at the command line to get instructions on the various options.

2. If “Assemble” does not situate your molecule(s) the way you would like, you can use the “Move Near” button, to move one fragment closer to another. Simply select the atom to which you would like to move the fragment closer. Click the “Move Near” button to enter the “move” mode. Click on an atom in the fragment that you would like to move. Press “Esc” to exit the mode.

3. Copy Near acts the same as Move Near, but generates a symmetry-related fragment and does
not delete the first fragment.

4. Click “center on cell” to **move all atoms as close to the center of the cell** as possible. This may disrupt catenated fragments. “Largest Part” will move all fragment close to the largest fragment.

5. To toggle a set of **Basis vectors** or the unit cell on and off, simply click “Show Basis” or “Show Cell” respectively.

6. If you want to **show more atoms than what are contained in your asymmetric unit**, you will need to use either the **grow** or **pack** commands. (You can type either of these words at the command line, though “pack” tends to give you many more atoms than you may want).

7. To **expand a structure which lies on a symmetry element**, or a polymeric structure, press “Grow All”. To be more discriminating in what you grow, use the Grow Mode button:
   a. Choose Short and/or VdW (van der Waals) and enter a value for the search radius (the default 2.0Å is often too short, so change it to 5Å). Click the Grow Mode button which will generate pink dashed lines showing possible contacts. Click any of these contacts to generate the next molecule over. Press “Esc” to exit Grow Mode.
   b. To delete a molecule or fragment you do not want, simply double click an atom in it to select the whole fragment and press “Delete”.
   c. To delete all “grown” molecules or atoms, click “Fuse” or type “fuse” at the command line.
   d. Alternatively, under the **Packing** menu, move the slider to “Expand Short Contacts (Hydrogen bonds)” to generate potential interactions. Click on the pink dashed bonds to produce the symmetry-generated molecule.

8. To **generate a packing diagram**, choose one of the following:
   a. Use the slider under **Pack Radius** to generate molecules that lie within a certain radius from the center of the structure as it is currently displayed (not necessarily the center of the cell or the origin).
   b. **Pack to limits** allows you to set a box into which you would like to pack molecules. Enter values for a, b, and c (min and max) and click “Pack to limits” to generate molecules that fall inside that range. The default values of -0.5 – 0.5 will generate molecules that have atoms lying +/- 0.5 unit cell units from the origin. Change these as necessary to create the look you want.
   c. Click the **Fill Unit Cell** link to generate all atoms which lie inside the unit cell. You will need to click “Complete Fragments” to generate all the bonded atoms which lie outside the unit cell. This method is highly effective!
   d. Again, press or type “**fuse**” to return to the asymmetric view only.

9. To **toggle the background** colors:
   a. Press F2 to toggle between solid blue and solid white
   b. Press F4 to toggle between gradient and solid white or blue.
   c. To change the colors of the background, at the command prompt type “grad” and press <enter>. This will pop up a dialog box that will allow you to choose the colors for the four corners of the image window. This may require a restart of Olex2 to take effect. Typing “grad –p=filepath” where “filepath” is the path to an image file, will set the
background to that image (stretched to fit). This requires a restart to take effect. To get rid of the image, type “grad –p” at the command prompt and press <enter>.

d. The default color for the background is given by the values below, in case you need to get back to it.

![Image of color palette](image)

**Figure 10.** The values for the default color in Olex2.

10. To **change atom colors**:
   a. Under the **Home** tab, click the **Settings** tab to expand it.
   b. Click Atom Styles to bring up a graphical periodic table.
   c. Right-click on the element you wish to edit (in the figure below, Fe).
   d. Choose Graphics → Draw style...
   e. This brings up a Materials Property window
   f. Choose “Sphere” to edit the color of the ball or ellipsoid and “Rims” to edit the octant lines for an ellipsoid from the drop-down box “Primitive.”
   g. For the Apply To drop-box
      i. Choose “Atom Type” to apply to all atoms everywhere.
ii. If you wish to change the color of one atom in a specific structure, select the appropriate atom from your structure model, follow the instructions above but choose “Individual Atom” from the Apply to drop-box.

iii. If you wish to change all instances of one atom in a structure (say, for a packing diagram you wish to change all Fe2 to a different color) see point ii above but choose “Atom Name”.

h. Click inside the color boxes to bring up a color palette and select the color you wish to use.

i. Once you have made your changes click “OK” to accept them.

Labeling atoms and Saving Images

Once you have a structural representation that you would like to save for a presentation or publication, you might want to label some or all atoms and you will certainly want to save the image for future use. These functions are handled under the Tools menu. Click the Tools button and then expand the Images tab by clicking on it. The commands below can be accessed from this panel.
11. To label all non-hydrogen atoms, click the link “non-H atoms”.

12. To label only certain atoms:
   a. Click to select the atoms you would like to label
   b. Click the link “Label selected”.

13. To add symmetry information or change the label style, use the drop-down boxes to the right (Symm, Style, respectively).

14. The labels will track with their associated atoms as you rotate the structure, however you might want to reposition them before saving the image. To do this hold down the Shift key while left-clicking on a label to drag it around on the screen.

15. To delete all labels, click the link “DELETE all labels”. To delete one or more labels, click to select (they will turn green) and then press the Delete key.

16. To change the label color, click the link “Choose the label color”. This will bring up a window in which you can click the color panel to change the label color. There is no way to change the colors of only some labels at this point.

17. To edit a label, double click the label you wish to edit and enter the new text in the dialog box that appears. Click “ok” to accept the new text.
   a. To add a subscript or superscript enter \- or \+ respectively before the text you wish to be affected. Likewise to turn sub- or superscripting off, enter \0.
      i. N\-1 = N\textsubscript{1}
      ii. N\+1 = N\textsuperscript{1}
      iii. (N\-2\textsubscript{0})\+1 = (N\textsubscript{2})\textsuperscript{1}

18. To change the label font, in the Bitmap Images submenu click the link for Atom “(System Font)” and select the font style, weight and point size you would like. Click “ok” to accept your
changes.
   a. There are many other options and ways to change label fonts and colors, which are
      beyond the scope of this manual.
19. To add a border to your image, use the “Trim” options in the Bitmap Images submenu. Check
    the box to add the border “trim” and customize it with the Padding and Border (%) options
    (make sure Border % is not 0). The Color is given by hexadecimal codes which can be found
    here: http://www.colorpicker.com or found elsewhere on the web.

20. To save the image as it appears in your Graphics Window, at the top of the Images tab, enter a
    name for the figure in the box. In the Bitmap Images submenu, in the drop-down box next to
    Type, choose the file format you wish to use (png, bmp, or jpg). Check the box if you would like
    a Transparent (not white) background. Customize the resolution by using the drop-down boxes
    on the next line. The default options produce high quality images. Click the “Go” button to save
    the image. The file will be saved to your current working directory.

Saving different file types

21. To save your structure model as a .res or .pdb file, at the command prompt type “file
    filename.ext” and press <enter>, where “filename” is the name you’d like to call the file and
    “ext” is the extension of the file type you’d like to save.
   a. For instance, to save a packing diagram as a pdb file, generate the packing plot as
      described above and then type “file filename.pdb” at the command prompt.
   b. If you have a disordered structure and want to save each part in its own individual .res
      file, first delete the part you don’t want (see Modeling disorder for instructions on how
      to do this), and then type “file filename.res”. Use Control-Z to restore the atoms you
      just deleted. Then, delete the other part and file it as a different file name. Remember
      to use Control-Z to restore the deleted atoms before continuing with another
      refinement.

22. To save a model to come back to at a later time (as a backup to the History tab for instance or to
    save a tediously generated interaction plot), at the command prompt type “save model
    filename” and press <enter>, where “filename” is the name you’d like to call the file.
   a. e.g. I generated a hydrogen bonding plot which I would like to save for future use. I
      type “save model hbplot” at the command line and Olex2 writes hbplot.oxm in my
      working directory

23. To return to a previously saved model, at the command prompt type “load model filename” and
    press <enter>, again where “filename” is the name of your model file.
   a. In the previous example, I would type “load model hbplot” to get back to the hydrogen
      bonding plot I had made.

Creating a CIF File

When you are finished refining your structure you will need to produce a completed CIF
(Crystallographic Information Format) file which will be submitted for publication. The IUCr journals
(Acta Crystallographica) require your entire paper be submitted as a CIF file. Other journals require the
CIF file as supporting information. There are several software programs freely available that can help
you edit a CIF file for publication in Acta Cryst style. Olex2 will help prepare your CIF file to some extent, though you will still need to do some editing by hand if you wish to submit it as a complete paper.

1. To prepare a CIF file, click on the √ button next to the Report button.

2. At times, Olex2 might pop up a warning box that there is conflicting information in its various source files. If that happens, simply click the correct entries, or type in your own user-supplied value to continue. In the case shown below, the correct option is given by “sad.abs” as “multi-scan”. Simply click the entry for “multi-scan” to clear the conflict.

3. Expand the “Source Files” tab at the very bottom of the panel. Make sure the proper pcf, p4p, and abs (if you ran SADABS) files are displayed. Click the folder icon to select a different file if you need to.
   a. Make sure you use the pcf file from your last run through XPREP (e.g. if you did a face-indexed absorption correction after the initial run through XPREP).
   b. Olex2 will let you know if you have outstanding conflicts or if they have all been resolved. Click the link to Reset Previously Resolved Conflicts if you want to undo your earlier selections.

4. Expand the “Absorption Correction” tab.
   a. In the box labeled Abs Type, select “multi-scan” from the drop-down box if you did a SADABS/TWINABS correction or “numerical” if you did a face-indexed correction.
   b. In the box for Abs Details enter information for the type of absorption correction. (This may already be filled out if you used SADBS).
   c. If Abs Tmax/Tmin are blank, fill in the values from your abs file (for SADABS) or pcf file (for Face-Indexed) (_exptl_absorpt_correction_T_max/min), otherwise check that they are the same (the abs/pcf values are the correct values).
   d. If your crystal was twinned, the Abs T max value will always reset to 1. You will need to manually edit the CIF file when you are finished compiling it with Olex2.
5. Expand the “Diffraction” tab.
   a. Under Diffractometer, type “Bruker Kappa APEXII” (unless you used a different system to collect the data).
   b. For Definition file, click the link and choose the appropriate file for your data collection:
      i. Moly.cif if you used MoKα radiation on either system
      ii. DuoCu.cif if you used the CuKα source on the Duo
      iii. Prospector.cif if you used the Prospector.
      NOTE: These files are unique to Northwestern and do not come with the standard Olex2 release. You will need to copy them to your local computer.
   c. Diffraction T (K) should be filled in. Check it against the value in the pcf file (_diffrn_ambient_temperature). Enter the value given in the pcf file if they are different.
   d. Cell Measurement T (K) should be the same value as Diffraction T (K) unless you knowingly changed the temperature between collecting the unit cell and the whole data set. Enter in the same value in that box.
   e. Add any Special Details or Refinement Special details in the appropriate boxes. If you need to explain any features of your refinement techniques (treatment of disorder, modeling hydrogen atoms), Refine Special Details is the place to do it.

6. Expand the “Crystal” tab.
   a. If you know it, you can enter the systematic name of your compound in the first box. Otherwise, leave it with a ?
   b. Olex2 will read in the colour from your pcf file so it is not necessary to add it here, even if it is not displayed. If you wish to add more information than the standard _exptl_crystal_colour included in the pcf you can choose the correct descriptors for each of the three boxes
      i. The first box gives _exptl_crystal_colour_lustre
      ii. The second box gives _exptl_crystal_colour Modifier
      iii. The third box gives _exptl_crystal_colour_primary
      iv. Olex2 combines the first and third boxes to generate or overwrite the required CIF item: _exptl_crystal_colour
   c. The size should be filled in for you, but you can find these values from the pcf file (_exptl_crystal_size_min/mid/max)
   d. Choose a shape from the drop-down box to the right of the crystal size. Olex2 will fill this in for you from the value in your p4p or pcf files.
   e. Enter as free-form text the Preparation Details, Crystallization Details and Crystal Mounting details if you so choose. These are not required CIF items for supporting information.

7. You may expand the other tabs (Collection, Publication and Reference) if you choose to add those particular bits of information to your file. They are not necessary at this point.
8. Use the Edit Cif Info button to change any CIF information that Olex2 wants to add to your file. Items that you entered in the above mentioned menus will appear in this box.

9. The IUCr now requires all CIF files to contain both refinement and hkl information. SHELX-2013 will append your .res and .hkl files to your CIF file. If you are not refining with SHELX-2013, change the “Ignore HKL/RES” to “Include HKL/RES” so this information will be appended to your CIF file. HKL checksum data may not be included which will result in a CheckCIF alert, so it is best to refine with SHELX-2013.

10. If you wish to include information from another CIF file you can use the “add CIF” link at the bottom of the Report menu (shown in the figure above).

11. Once you have added all your information, press the “Merge Cif” button. This will stitch together the CIF file generated from your refinement, with your pcf file and the other information you provided in the Olex2 GUI. Note: If you run another refinement, it will overwrite this CIF and you will have to press the “Merge Cif” button again.

12. Olex2 will pop up a text editor with your CIF file in it. You can scroll through the file to make sure the proper values have been included in it. Leave this file open for now.
   a. Note: For older versions of SHELXL you will need to check this: One item that you will consistently need to check and/or fix is the “_refine_ls_hydrogen_treatment.” This is set by the refinement program and for SHELXL will default to “mixed” meaning some atoms were freely refined and some were constrained (riding). If you only had riding hydrogen atoms you will need to change this to “constr”. CheckCIF will display a B-level alert if you have left this value incorrect. Look for the alert in CheckCIF.
   b. The newest version (SHELXL-2013) corrects this problem. Make sure you know what version you are using so you know if you need to correct this problem!
   c. Currently, Olex2 overwrites this value with “mixed”. Future versions will fix this issue, but it is best to check/edit your CIF after you are done working in Olex2.

13. Back in the Olex2 GUI, click the “Get CheckCif Report” button. This may take a while, but it will generate a CheckCIF report for your file. Look through it for any errors or alerts and edit your CIF file accordingly. (This will be discussed in detail in class).
   a. Note: This CheckCIF algorithm may not be as up-to-date as the IUCr CheckCIF function available on the web.
   b. To access the IUCr CheckCIF routine open a web browser and navigate to http://journals.iucr.org/services/cif/checkcif.html
   c. Browse to your cif file and select the box for Validation of CIF only (no structure factors). Click “send CIF for checking”. NOTE: The IUCr now requires submission of the structure factor CIF (.fcf) file. It is a good idea to run your .fcf file through CheckCIF, too.
   d. Further instructions will be given in class for how to answer alerts and fix common problems.

14. Once your CIF file is complete, you can use it to make Acta Cryst type reports, or use the Olex2 GUI to customize your own reports. These procedures will be discussed in class.
Advanced Topics

The following topics will be discussed in class if time allows. The guides below are by no means comprehensive, but can serve as a launching point or a reminder. If you experience any of these phenomena, seek help from an expert.

Noncentrosymmetric or Chiral Structures

Eventually, you will come across a crystal structure that lacks an inversion center, whether it is non-centrosymmetric or chiral. It is important to remember that a chiral molecule can never exist in a space group with an inversion center or mirror plane.

If you do have a structure that is non-centrosymmetric or chiral, you will need to pay attention to the Flack and/or Hooft parameters. Both parameters give an estimation of the likelihood that the current structural model has the correct handedness, though they are based on different data. The value of each should be 0 for the correct model and 1 for the incorrect model.

The Flack parameter is calculated by XL during the refinements and can be found in the lst file. It has been the standard parameter for assessing chiral structures for many years. The Hooft parameter is based on statistics in the data and is calculated by Olex2 (or in PLATON). Olex2 outputs the values of each parameter at the end of each refinement cycle in the Graphics Window.

If your Flack parameter is closer to 1 than to 0, XL may display a warning that your absolute structure is wrong and your model should be inverted. Olex2 will also display a warning:

```
Checking absolute structure...
Hooft y: 1.00(2)
Flack x: 0.998(15)
WARNING: Structure should be inverted (inv -f), unless there is a good reason not to do so.
```

To invert your structure, type “inv -f” at the command prompt and press <enter>. This will apply an inversion to the coordinates of the atoms in your structure x y z → -x -y -z. Run another refinement cycle and check the values of Hooft and Flack:

```
Checking absolute structure...
Hooft y: 0.00(2)
Flack x: 0.002(15)
OK
```

After inversion, these parameters are much better.

There are times when these parameters fall between 0 and 1 and have large enough esd’s that it is impossible to tell which is the correct hand. There are many reasons for this:

- Light-atom structures collected with MoKα will have no discernible anomalous dispersion and Flack will be meaningless (Hooft might still give some information – this is a current topic of debate).
• Poor data quality will result in poor calculations of each parameter.
• Structure is really racemic and you have chosen an incorrect space group.
• Structure is racemically twinned.

Investigate these reasons and if you still have trouble, consult an expert.

When you report a noncentrosymmetric or chiral structure, you need to add a line to the CIF file, _chemical_absolute_configuration, which indicates how you determined the absolute configuration. If you did this by looking at the Flack parameter, choose “ad” (anomalous dispersion). If you had a reference molecule in the structure (like a known chiral salt) choose “rm”. If a known stereocenter was preserved through the synthetic method, choose “syn”. If you cannot determine the absolute configuration choose “unk” and if it is meaningless (e.g. an achiral molecule) choose “.”. The combination “rmad” is also acceptable.

### Twinning

Often crystals that are submitted for data collection are twinned in one of several ways, defined by the nature of the twin law relating the separate crystalline domains. The twin law is the matrix needed to transform one domain into the other. Merohedral twinning occurs when the twin law coincides with a symmetry element of the crystal system, but not the point group of the structure. This leads to an exact overlap of reflections from each component and is not readily detectable from the diffraction pattern. Merohedral twinning (aside from Racemic twinning) can only occur for crystal systems with more than one Laue group: trigonal, tetragonal, hexagonal and cubic. Pseudo-merohedral twins have a twin law that is of higher metric symmetry than the true crystal class; for example, a monoclinic crystal with a β angle near 90° and the a- and c-axes nearly equal. If the metric symmetry is close enough to emulating an orthorhombic cell, the spots from twin domains may exactly overlap and this may not be detectable from the diffraction pattern. If you are having difficulty refining a structure that is a candidate for either Merohedral or Pseudo-Merohedral twinning, consult an expert for how to proceed.

In a more common form of “twinning” – which is not true twinning, but rather crystal intergrowth or just “bad” crystals – the resultant diffraction patterns from each twin domain do not exactly overlap. These cases are typically easy to spot from the diffraction pattern and a twin law can readily be determined.

The Bruker program Cell Now is used to determine the twin law and therefore the orientation matrices of each twin domain. After the data are integrated, the APEX2 software will generate a .mul file instead of a .raw file (mul = multiple). This .mul file is read by the program TWINABS, which separates the components, scales them (like SADABS) and produces an HKLF4 (standard) format file to use in XPREP and to solve the structure. TWINABS also produces an HKLF5 (twin) format file, which contains the reflection data from each component. Once you have solved the structure with the HKLF4 file, you can refine against the HKLF5 data and determine the contribution of each component.

Assuming you have been provided with HKLF4 and HKLF5 files, follow the steps below:

1. Use the HKLF4 file to determine the space group (in XPREP) and solve the structure as you would normally do.

2. Once you have a good structural model (not necessarily complete, but at least stable) you can begin to refine against the HKLF5 file.
3. In the **Refine** panel, use the drop down box to select the HKLF5-format file for the “Reflection File.”

4. Edit your ins file to add “BASF 0.5” on a line somewhere above the atom list. This sets the “BAtch Scale Factor” to 50%, indicating each component contributes 50%. This number will be refined during the least-squares cycles.

5. Scroll to the bottom of the ins file, and change the line “HKLF 4” to read “HKLF 5”. This instructs XL to use the “batch number” at the end of each HKL I sig(I) line to determine which component the given reflection belongs to.

6. Save these changes and close the ins file.

7. Continue to refine the structure as you normally would. Check in the lst file for the value of BASF and its esd which you will need to report in your CIF file.

8. In this case, TWINABS applies the multi-scan absorption correction, so you will need to edit those values in your CIF file. The Tmin and Tmax can be found in the *.abs file.

9. You should also include some text in your refinement_details section to describe the twinning. The final twin law can be found near the bottom of the _0m._ls file, and the Cell Now output file *._cn will have the rotation operation (e.g. 179° around the direct/reciprocal 0.000 0.000 1.000 axis).

10. You might find that there is little improvement to using the HKLF5 data. It is acceptable to use only the HKLF4 file if you have enough data, but you still need to comment in your CIF file that the crystal was twinned.

### Modeling disorder

Chances are during your lifetime you will encounter one or more structures that exhibit disorder. Most disorder problems can be diagnosed by looking at the size and/or shape of the displacement parameters or by finding higher-than-noise Q-peaks which make unreasonable interactions. SHELX programs and Olex2 will warn you if atoms appear to be split, which is a good sign you should be looking for disorder. Typical disorder occurs around freely rotating bonds (e.g. long alkyl chains or terminal CF₃ groups) or in solvent channels that are larger than the solvent molecules accommodating them. Some disorder is merely occupational disorder – two metal cations split over the same site, a partially occupied solvent molecule – and other disorder is both occupational and positional. We will deal with each briefly below.

#### Occupational Disorder

Take for example the compound UYb₂O₂Se₃. In this structure the U and one Yb occupy the same site in the crystal structure (0 0 z). This would become apparent as the displacement parameter for the atom on that site would be poorly behaved. With U fully occupying the site, the Uᵢ of the site would become too large; with Yb fully occupying the site, it would become too small. Clearly something is not right.
An investigation of the geometry of the site and the chemistry involved, would lead to a conclusion that the site is partially occupied by both U and Yb in such a way that the charges of the system should balance. In this case, the site must be half occupied by U and half by Yb for the charges to balance.

Once the atom site is located, the task is to split the site between U and Yb so that they both have the same coordinates and the same displacement parameter.

The atom list in the ins file would look like this:

```
L.S. 4
.
.
.
EADP U1 Yb1
EXYZ U1 Yb1

WGHT  0.033200
FWAR  0.21729
  U1  4  0.000000  0.000000  0.307839  10.06250  0.00548  0.00548 =
       0.01240  0.00000  0.00000  0.00000
  YB1  3  0.000000  0.000000  0.307839  10.06250  0.00548  0.00548 =
       0.01240  0.00000  0.00000  0.00000

The EADP and EXYZ commands tell SHELX to constrain the displacement parameters (EADP) and coordinates (EXYZ) to be equal. You can see in the atom list that indeed the coordinates and displacement parameters are identical. (EADP works for isotropic displacement parameters, but both atoms must be refined in the same manner).

The International Tables gives the multiplicity of the 0 0 z site in this space group (I4/mmm) as 4, which, given the 32 general positions, leaves the site occupancy at 1/8th for the 0 0 z site (4 ÷ 32 = 1/8). For the charges to balance the site must be split equally between the two atoms, so the s.o.f. field for each atom is set to 10.06250 (1/2 x 1/8 = 1/16 = 0.0625).

Now let’s consider the case where the occupancy is not dependent on charge balance. It is possible to refine the occupancy of a site by tying it to a free variable (FVAR). In this case, the example above would look like this:

```
L.S. 4
.
.
.
EADP U1 Yb1
EXYZ U1 Yb1

WGHT  0.033200
FWAR  0.21729 0.50
  U1  4  0.000000  0.000000  0.307839  20.12500  0.00548  0.00548 =
       0.01240  0.00000  0.00000  0.00000
  YB1  3  0.000000  0.000000  0.307839 -20.12500  0.00548  0.00548 =
       0.01240  0.00000  0.00000  0.00000

Look at the underlined values. You should notice a second value on the FVAR line. This is FVAR(2) and is used to refine the occupancies. To start, we have given it a value of 0.5 (50%). Now look at the s.o.f. values for U1 and Yb1. These have changed from 10.06250 to 20.12500 and -20.12500. The “2” refers to FVAR(2) and the “-2” refers to 1 - FVAR(2). The “0.12500” is the occupancy/multiplicity of the site if it were fully occupied (1/8th). The s.o.f. for U1 is thus given by FVAR(2) x 0.12500; for Yb1 it is (1 - FVAR(2))
\[ \times 0.125000 \]. Simple algebra shows that the total site occupancy will equal 0.12500 (as it should for a fully-occupied site).

After a cycle of refinement there will be an esd associated with FVAR(2) which can be found in the lst file under the atom list (s.o.f.) section:

<table>
<thead>
<tr>
<th>ATOM</th>
<th>x</th>
<th>y</th>
<th>z</th>
<th>sof</th>
<th>U11</th>
<th>U22</th>
<th>U33</th>
<th>U23</th>
</tr>
</thead>
<tbody>
<tr>
<td>U1</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.30784</td>
<td>0.06352</td>
<td>0.00548</td>
<td>0.00548</td>
<td>0.01240</td>
<td>0.00000</td>
</tr>
<tr>
<td></td>
<td>0.00122</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.00006</td>
<td>0.00027</td>
<td>0.00073</td>
<td>0.00092</td>
<td>0.00000</td>
</tr>
<tr>
<td>Yb1</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.30784</td>
<td>0.06148</td>
<td>0.00548</td>
<td>0.00548</td>
<td>0.01240</td>
<td>0.00000</td>
</tr>
<tr>
<td></td>
<td>0.00122</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.00006</td>
<td>0.00027</td>
<td>0.00073</td>
<td>0.00092</td>
<td>0.00000</td>
</tr>
</tbody>
</table>

The first line for each atom gives the values of the various parameters. The second line gives the esd’s for those values. Notice in the sof line, how the occupancies have drifted away from an exact 50/50 split. However, the errors show they are still within that range.

Note: Crystallography should not be used as a form of elemental analysis. The correlation between displacement parameter size and site occupancy makes this an unreliable technique for such a determination. It is best to have additional evidence to support the s.o.f. values you determine from the diffraction experiment than to use those values to support other claims.

In modeling occupational disorder, you will be editing the ins file by hand:

1. Copy the coordinates of the affected site for each atom that resides on it; making sure to change the atom label and SFAC value accordingly.

2. Edit the sof value either to set it manually to a known value (as in the first case) or to a free variable to be refined (as in the second case).

3. Finally, add the appropriate EADP and EXYZ constraints to keep the atoms positioned on the exact same site.

4. Refine the structure as usual, paying close attention to the size of the displacement parameters as well as the sof if you are refining it.

5. Olex2 will mark atom sites that are occupied by more than one atom with an EXYZ band around the atom sphere or ellipsoid.

Positional Disorder (GUI method)

Olex2 has many powerful tools for working with positional disorder, including the ability to move atoms anywhere in the crystal structure. Obviously, these tools can cause serious issues if not used properly. Take care when you perform the following actions and remember that you can always go back through your history to return to a better state.
Let us take an example of a disordered C-C single bond (THPP demo structure in Olex2). The disorder becomes apparent when we see the highest Q-peaks in the map correspond to a different orientation of the C-C bond. To model this disorder, we will use the disorder tools available in the Toolbox Work panel.

1. Before you begin, it is easier to work with disorder if you have already labeled the atoms in your molecule appropriately.

2. Delete any hydrogen atoms that are riding on disordered atoms. You will generate them again later, but it is easier to get them out of the way while you are working.

3. Click to select the atoms you wish to split.

4. While these are highlighted, click in the drop-down box next to “Select group or atom(s) and then” and select “split”.

5. This will create a second set of atoms directly overlaid on the first set, but colored green. Your original atoms will be colored purple.

6. Click on a part of the second set of atoms and drag with the mouse to position it in the place you would like (in this case, over the Q-peaks). Use shift-click to drag the selection in the plane of the screen, and Ctrl-click to rotate in the plane of the screen.

7. When you have the atoms positioned where you would like them, press Esc. to exit the Split Mode. You will now have two separate parts that correspond to each disordered component.

8. If you exit the Split Mode and decide you don’t like the positions of the atoms, click to select them again and choose “fit” in the drop-down box for the “Select group or atom(s) and then” option. Move the atoms again and press Escape to exit the mode. (This feature works for any atom you wish to select and move – USE WITH CAUTION!)

9. Olex2 names the split atoms according to their “parent atoms” and automatically inserts the proper commands into your ins file.
   a. The original atoms C2A and C3A give rise to the split atoms C2B and C3B.

10. The PART N command tells XL which atoms belong to which disordered components in order to prevent “bonds” appearing in the connectivity list to atoms in different components. Typically the major component will be given in PART 1 (e.g. C2A, C3A) and the minor component in PART 2 (e.g. C2B, C3B).
11. The sof’s will need to be refined, and Olex2 will add the appropriate FVAR entries, as well as edit the sof’s for the affected atoms.

FVAR  0.37389  0.75
.
.
PART 1
C2A   1     0.30834  1.20187  0.71223  21.00000  0.02599
C3A   1     0.36402  1.13434  0.82049  21.00000  0.02599
PART 0
PART 2
C2b   1     0.41321  1.19320  0.73033  -21.00000  0.05000
C3b   1     0.27572  1.13932  0.81497  -21.00000  0.05000
PART 0

Olex2 has set the FVAR(2) value to 0.75, making the assumption that the disorder is skewed away from a 50/50 split. This is reasonable, since the residual electron density was not on the order of even half a carbon atom.

12. Olex2 will keep track of the number of different FVAR’s needed if you add another set of disordered atoms whose occupancies are tied to each other, but not necessarily tied to the first set of disordered atoms. You can edit the values that Olex2 uses if you wish to tie them all together, or if you wish to change the starting value of FVAR(n).

13. Refine the structure through once. Then, add hydrogen atoms as you normally would. Olex2 will handle assigning them to the appropriate PARTs and the appropriate sof variables.
   a. Olex2 will also split riding hydrogen atoms on adjacent (non-disordered) atoms to correspond to the correct orientation for each disordered component. (You will have to delete any existing hydrogen atoms and re-add them.

14. Again, pay attention to displacement parameters and values for any FVAR that you set. And judge the disordered model accordingly.

15. It is possible that you will discover disorder by the shape of anisotropic displacement parameters, not by the position of residual electron density peaks. You can follow the steps above, moving the split atoms to a site you feel is appropriate. If after one or two refinement cycles, the disordered atoms drift away or into nonsensical positions (or have very low values for sof and/or high values for U\textsubscript{ij}, chances are that the disorder model is not correct.

Positional Disorder (Text-only version)

Olex2 and SHELXL will notify you of atoms it believes to be split over two positions. Olex2 will show the affected atoms as output in the Graphics Window after every refinement cycle. These atoms are also listed in the lst file after the list of refined atom positions. (Search the lst file for the words “may be split” to go right to that section). The lst file lists each atom that may be split, along with the sets of coordinates corresponding to each position.

1. To set up disorder using this list, open the lst file to this list and keep it open in a text window. You will be copying the coordinates from this file.
2. Open your ins file and scroll to the affected atoms.

3. It is best to start modeling this disorder with isotropic displacement parameters, so delete the anisotropic displacement parameters for each affected atom.
   a. Your atom line should have the atom label, the SFAC value, x, y, z, sof, and Uij values only (7 entries).
   b. Change the Uij value to 0.05 if it is any larger than that.

4. Copy the lines for each affected atom and paste them in below. You can either do this in blocks if you have a long string of disordered atoms, or one-by-one. Be sure to change the atom names for those in PART 2. (e.g. C3 to C3A).

5. Place a PART 1 command on a separate line above each atom or block of atoms that belong to one component. Place a PART 0 on a separate line at the end of the block.

6. Likewise, set up the PART 2 commands surrounding the atoms of the second component.

7. Find each affect atom’s split coordinates in the lst file. Copy the first set of coordinates to the corresponding atom in PART 1. Copy the second set of coordinates to the corresponding atom in PART 2. Repeat this for each affected atom.

8. Edit the sof values for each component (21.000 and -21.000) accordingly and remember to set a new variable on the FVAR line.

9. Your ins file should be set up similar to the example above.

10. **NOTE:** This method will not always split atoms according to their components (i.e. the first set of coordinates for each atom might not all correspond to PART 1). You should check the model after the first refinement to be sure the atoms are assigned to the proper components. If you need to move an atom from one component to the other, simply swap coordinates (for instance C3 at x y z and C3A at x’ y’ z’, switch the coordinates so C3 is at x’, y’, z’ and C3A is at x, y, z).

11. If your model is stable after a few refinements, continue on by refining anisotropically and adding hydrogen atoms. Olex2 will set up the proper PARTs and sof’s for any hydrogen atoms it adds.

12. **You can combine aspects of both the GUI and text-only methods as you see fit.** If you want to let Olex2 split atoms for you, you can use it to set up the ins file, but then edit the coordinates by hand from the lst file.

13. There are many ways to finesse disorder models both by editing files by hand, and by using Olex2 to shift atoms graphically. As you work with disordered structures, you will find the best ways that work for you and your structures.
**Viewing Disordered Structures and Other Tools**

In the Olex2 GUI, click on the **Tools** tab to switch to the Tools menu. Expand the “Disorder” window by clicking on it. There are many functions available here for dealing with Disorder. You can select groups of atoms and link their occupancies and/or parts. You can assign atoms to specific parts. Perform these tasks by clicking on the appropriate links. As always, check your ins files to be sure the commands have executed properly.

The Disorder menu is most useful for displaying each part individually. To do this, use the “Show PART” links. Atoms which are not disordered (assigned to a PART) are automatically in PART 0. The various links will display ordered atoms + PART 1 (0 1), ordered atoms + PART 2 (0 2), disordered PART 1 + PART 2 (1 2), PART 1 alone (1), PART 2 alone (2), and all atoms (ALL), respectively.

You can reference atoms of each PART N on the command line by using “part n”. For example, if you wish to select all the atoms of PART 2, at the command prompt type “sel part 2” and those atoms will be highlighted.

**External Resources**

Olex2 is a powerful GUI for structure solution and refinement. This manual only briefly touches on many of the features you can use to solve, refine, model and display your structures. Over time you will discover many tricks and shortcuts not presented here. There are many excellent resources for help with Olex2.

Click on the “home” icon to return to the Olex2 home screen. At the bottom of this screen are links to John Warren’s Olex2 xForum (the overall forum is an excellent resource for all manner of crystallographic questions), a searchable command manual, the original paper describing Olex2, and the Olex2 website. The crystallographic community is small and generally friendly. Old-timers are usually willing to help out new-comers with even the most basic questions. Often throughout this guide you find the words “consult an expert.” This is a mantra that will serve you well as you work through your structures. Crystallography (as with most science) is not done in a vacuum, unless you are doing ultra-low pressure work, I suppose. Seek out advice from your advisers, staff crystallographers or internet forums. You will most assuredly find someone who can get you the help you need.

Good luck, and happy solving!